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The creation and distribution of this manual is a joint project bringing together the 

Australian Seniors Computer Clubs Association and Media Access Australia. 

 

ASCCA is the National Peak Body for 

Seniors and Technology. It is run by 

seniors for seniors.  

ASCCA’s services are provided by volunteers to assist older and disabled Australians  

to access computer technology. It is a Public Benevolent Institution and endorsed as a 

Deductible Gift Recipient by the Australian Taxation Office.  

 

The Association will help start new clubs, advise and assist existing clubs; undertake 

research projects; liaise with the three spheres of Government and other organisations on 

behalf of the membership, organise seminars and like activities and seek out discounts for 

members. It provides a channel for communication between like-minded people, who 

want to share in the potential of the computer age to serve their individual and community 

goals.   

 

ASCCA seeks to serve the Seniors of Australia by providing information, training, 

forums, seminars and workshops relevant to Information Communications Technology 

and other issues of importance to seniors or older people with a disability.  Members with 

disabilities include those who have had strokes, are vision or hearing impaired, suffer 

from MS, Motor Neurone Disease, Parkinson's, etc.  ASCCA also understands that many 

disabilities that affect their members are actually a normal process of ageing so they 

encourage them when possible to continue enjoying and benefiting from the use of their 

computer.   

 

 

 

Media Access Australia (MAA) is a not-for-profit, public benevolent 

institution providing information about technological solutions to 

media access issues, and promoting increased usage of these solutions 

for people with disabilities. New media, including access to computers, 

computer software and the internet, is an area we are increasingly 

focusing on due to its importance as a media channel in our society. 

 

The gradual onset of disabilities can be challenging, particularly with using computers or 

accessing other forms of media. Many seniors experience gradual loss of vision, hearing 

or mobility. There are many specialist solutions that have been developed to overcome 

these, but they tend to be complicated, expensive and provide limited value to somebody 

with a mild loss. MAA is pleased to join with ASCCA to provide everyday, simple, low-

cost solutions to basic computer and internet problems encountered by people with onset 

of disabilities. In Australia the number of people with disabilities is growing as our 

population ages. This manual is part of the resources available to seniors to assist with 

accessing computers and other media. Other useful information and advice can be found 

at www.mediaaccess.org.au . 

http://www.mediaaccess.org.au/
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FOREWORD   

 

When I think about the Internet, I realise that it’s a pretty amazing piece of technology.  If 

it were thought of as a single computer, it would be the only computer in history that has 

stayed online since its inception, never broken down, has always expanded and has a 

majority of the world's population interacting with it.   

 

Yet for people with disabilities, the machine we know as the Internet offers more than the 

sum of its parts.  As a person with a vision impairment, I’ve found that the Internet offers 

all the same benefits to me as it does to the general public:  I can access e-mail, publish 

photos online and my family can see me through video phone calls.  And while these 

things are important, the Internet’s true benefit to a person with a disability is more about 

hope and independence.   If I were to travel back in time 20 years ago, a simple task like 

reading a book would involve a lot of assistance:  help to find the book, help to make the 

print larger, and even help just to get to the building in the first place.  Today, with the 

right tools, I can access the world’s libraries.  I can see photos clearly on the computer 

with a magnifier, and I can chat online with other people in my situation.    Best off all, I 

can do all this myself.  

 

In most cases, all the tools needed by people with disabilities are already installed in 

Windows and web browser applications.   This manual has been created by Media Access 

Australia as a companion for use in combination with other ASCCA courses.  If you need 

any extra help after working through this manual, or want more information on additional 

accessibility products and services, please contact Media Access Australia.  Further 

information can be found in the Additional Tools and Resources section.  

 

Kind regards,  

 

 

 

Dr Scott Hollier 

Project Manager, New Media  

Media Access Australia  
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2.0 WHAT IS ACCESSIBILITY?  
Accessibility, in computing terms, generally refers to the provision of a tool or application 

that makes it easier for people with disabilities to use a piece of technology.  In this case, 

the focus is on making a Windows-based computer and an Internet web browser easier to 

use.   

 

Generally an accessibility tool or application is used in conjunction with an application to 

achieve a particular task.  For example, a person who is vision impaired may use the 

Magnifier accessibility tool in conjunction with Microsoft Word to make it easier to see 

the text in a Word document.  Another example would be a person with a mobility 

impairment using the On-Screen Keyboard with a web browser to type text into a search 

engine.   

 

Legislation in the United States of America requires software developers and equipment 

providers to include accessibility features if they wish to sell their product to the United 

States Federal government.   As a result, nearly all modern day computers contain a 

number of accessibility features.  

 

3.0 PRODUCT VERSIONS ADDRESSED IN THIS MANUAL  
This manual provides accessibility information for the following operating systems:  

 Microsoft Windows XP with Service Pack 3 

 Microsoft Windows Vista with Service Pack 1 

 Windows 7 public beta release, build 7000 January 2009  

 

The manual also provides accessibility information for the following web browsers:  

 Microsoft Internet Explorer 7  

 Microsoft Internet Explorer 8 

 Mozilla Firefox 3 

 

NOTE: At the time of writing, Microsoft Windows 7 and Microsoft Internet Explorer 8 

had not been officially released and information provided in this manual is based on beta 

test releases.  As such, features and commands discussed in this manual for these products 

may change in the final release.   

 

4.0 WINDOWS AND WEB BROWSER ACCESSIBILITY 
FEATURES 

4.1 What accessibility features are in Windows?   

Current versions of Windows such as Windows XP, Windows Vista and Windows 7 

contain many accessibility features which can make computers easier and more 

comfortable to use.  Microsoft puts these features into the following categories:  

 Display and readability  

 Sounds and speech  

 Keyboard and mouse  

The features that relate to display and readability focus primarily on the needs of people 

with print disabilities or people who are vision impaired.  The sounds and speech section 

caters primarily for people who are hearing impaired and people who are blind.  The 
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keyboard and mouse features cater primarily for people with a mobility impairment, along 

with some assistance to people who are vision impaired.  

 

The features relating to display and readability include:  

 Adjustment of the font size on the desktop;  

 Adjustment of the desktop icon size; 

 Adjustment of the screen resolution;  

 Adjustment of the colours, such as the use of a high contrast colour scheme;  

 Adjustment of the cursor width and blink rate; and the 

 Magnifier application. 

 

The features relating to sound and speech include:  

 Adjustment of the sound volume;  

 The ShowSounds and SoundSentry features which present visual alerts in addition 

to audio alerts;  

 Toggle Keys which provide audio effect when Toggle keys are enabled, such as 

CAPS LOCK; and  

 Text-to-speech through the Narrator application.  

 

The features relating to the keyboard and mouse include:  

 Adjustment of the mouse double-click speed;  

 Adjustment of mouse pointer movement speed;  

 Adjustment of the mouse pointer size and trails;  

 ClickLock, which allows icons to be dragged without holding down the mouse 

button; 

 Mouse Keys, which allows the mouse pointer to be moved using the keyboard; 

 Sticky Keys to use command keys such as SHIFT and ALT without having to 

keep it held down; 

 Filter Keys to remove accidentally repeated keystrokes; and the 

 On-Screen Keyboard application. 

  

In addition, Windows Vista provides an ‘Ease of Access’ manager, a greater emphasis on 

speech recognition, improved ‘under the bonnet’ accessibility support and enhancements 

to existing utilities.  Windows 7 builds on the Vista framework by including some of the 

additional accessibility features such as an enhanced full-screen version of Magnifier and 

a predictive text feature in the On-Screen Keyboard.  

 

4.2 Which features in Windows best support my disability?  

The following table may help in identifying which accessibility features are most likely to 

assist with a particular type of disability.   

 

 

FEATURE VISION HEARING MOBILITY 

DISPLAY AND READABILITY     

Desktop font size Yes No No 

Desktop icon size Yes No No 

Screen resolution size Yes No Yes 

Colour themes and schemes Yes No No 

Cursor width and blink rate Yes No Yes 

Magnifier  Yes No No 
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SOUND AND SPEECH    

Sound volume No Yes No 

ShowSounds and SoundSentry No Yes No 

Toggle Keys Yes No No 

Narrator (text-to-speech)  Yes No No 

    

KEYBOARD MOUSE    

Mouse double-click speed No No Yes 

Mouse pointer movement speed Yes No Yes 

Mouse pointer size and trails Yes No No 

ClickLock No No Yes 

Mouse Keys No No Yes 

Sticky Keys No No Yes 

Filter Keys No No Yes 

On-Screen Keyboard No No Yes 

Figure 4.1 Table of Windows accessibility features and their relevance to specific 

disability groups 

 

Please note that this table should be used as a guide only and tools not listed as being 

applicable to a particular type of disability may still prove beneficial.  

 

4.3 What other accessibility features are in my web browser?   

Web browsers such as Internet Explorer and Firefox contain additional accessibility 

features which can offer further assistance to people with disabilities who rely on the  

use of a keyboard or need to make a webpage easier to see.  This manual provides 

information on how to magnify a webpage, adjust the colours and enable other built-in 

accessibility features.  

 

  



 7 

5.0 USING WINDOWS ACCESSIBILITY FEATURES  

5.1 Display and readability  

5.1.1 Changing the font size, icon size and screen resolution  

Changing the font size, icon size and screen size can all be achieved with one process.  

The easiest way to achieve this is by changing the screen resolution.   

 

 
 

Figure 5.1 Changing the screen resolution in Windows XP 

 

 Windows XP:  

1) Select the ‘Start’ button. 

2) Select ‘Control Panel’.  

3) In the Control Panel, select ‘Display’.  If there is no ‘Display’ icon you may need 

to switch Control Panel into Classic View.  This can be done by selecting the 

words ‘Switch to Classic View’ located on the left-hand side of the Control Panel. 

4) In the Display window select the ‘Settings’ tab, located towards the top-right 

corner of the window.  

5) Halfway down the window on the left side you will see a slider bar labelled 

‘Screen resolution’.  Select and hold the slider bar.  To make the text larger, move 

the slider bar to the left.  To make the text smaller, move the slider bar 

      to the right. 

6) Select the ‘OK’ button.   
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Figure 5.2 Changing the screen resolution in Windows Vista 

 

Windows Vista:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ’Appearance and Personalization’. 

4) Select ‘Personalization’.  

5) Select ‘Display Settings’ located towards the bottom of the window. 

6) Halfway down the window you will see a section titled ‘Resolution’ with a slider 

bar.  Select and hold the slider bar.  To make the text larger move the slider bar to 

the left.  To make the text smaller move the slider bar to the right.  

7) Select the ‘OK’ button.   

 

 
 

Figure 5.3 Changing the screen resolution in Windows 7 
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Windows 7:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ’Appearance and Personalization’. 

4) Select ‘Display’. 

5) Select the ‘Change display settings’ link towards the top of the window on the 

left-hand side.   

6) In the ‘Resolution’ section select the pull-down bar, and a slider bar should 

appear.  Move the slider bar down to make the text larger or move it up to make 

the text smaller. 

7) Select the ‘OK’ button.  

 

5.1.2 Changing the colours to high contrast  

Changing the Windows colours to high contrast can help reduce glare or improve the 

clarity of the picture on the screen.   

 

 
 

Figure 5.4 Changing the colours to High Contrast Black in Windows XP 

 

Windows XP:  

1) Select the ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Display’.  If there is no ‘Display’ icon, you may need 

to switch Control Panel into Classic View.  This can be done by selecting the 

words ‘Switch to Classic View’ located on the left-hand side. 

4) In the ‘Display Properties’ window select the ‘Appearance’ tab, located towards 

the right middle of the top of the window. 

5) Halfway down the window, on the left side, you will see a pull-down bar labelled 

‘Windows and buttons’.  Change this to ‘Windows Classic Style’. 

6) Underneath you will find another pull-down menu labelled ‘Color Scheme’. 

Change this to a high contrast colour scheme, such as ‘High Contrast Black’ 

7) Select the ‘OK’ button.  
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Figure 5.5 Changing the colours to High Contrast Black in Windows Vista 

 

Windows Vista:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ’Appearance and Personalization’. 

4) Select ‘Personalization’.  

5) Select ‘Theme’ located towards the bottom of the window. 

6) In the ‘Theme’ pull-down bar choose ‘Windows Classic’. 

7) Select the ‘OK’ button. 

8) You should now be back in the ‘Personalization’ window.  Select ‘Windows Color 

and Appearance’.  

9) In the ‘Color scheme’ section select a high contrast colour scheme.  

10) Select the ‘OK’ button.  

 

 
 

Figure 5.6 Selecting a high contrast colour scheme in Windows 7 
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Windows 7:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ’Appearance and Personalization’. 

4) Select ‘Personalization’.  

5) Select the theme that you wish to use such as those in the ‘Ease of Access 

Themes’ section.  

 

5.1.3 Cursor width and blink rate  

Changing the cursor width and blink rate can make it easier to see the cursor and control 

the text.  

 

 
 

Figure 5.7 Cursor width and blink rate settings in Windows XP 

Windows XP:  

1) Select the ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Accessibility Options’.  If there is no ‘Accessibility 

Options’ icon you may need to switch Control Panel into Classic View.  This can 

be done by selecting the words ‘Switch to Classic View’ located on the left-hand 

side. 

4) The ‘Accessibility Options’ window should appear.  Select the ‘Display’ tab 

located in the top-middle of the window. 

5) In the ‘Cursor Options’ section located halfway down the screen a ‘Blink Rate’ 

slide bar can be selected.  Select and hold the bar, moving it left to slow down or 

stop and right to speed it up. 

6) Underneath is a second slide bar for the cursor width.  Move it left to make the 

cursor more narrow and right to make it thicker. 

7) Once the preferences have been set, select the ‘OK’ button.  
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Figure 5.8 Cursor width and blink rate settings in Windows Vista 

 

Windows Vista and Windows 7:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Ease of Access’. 

4) Select ‘Ease of Access Center’. 

5) Select ‘Make the keyboard easier to use’.  

6) In the ‘See also’ section at the bottom of the window select ‘Keyboard settings’  

7) To adjust the repeat delay select and hold the first slide bar.  Moving the bar to the 

left will make the delay longer, moving it right will make it shorter.  

8) To adjust the repeat rate select and hold the second slide bar.  Moving to the left 

will slow down the repeat rate, moving it to the right will speed it up.  

9) To adjust the cursor blink rate select and hold the third slide bar, located towards 

the bottom of the window.  Move the bar left to slow down the blink rate and right 

to speed it up.  

10) Select the ‘OK’ button.  

 

5.1.4 Magnifier 

The Magnifier is a major accessibility feature in Windows.  In Windows XP and Vista 

Magnifier puts a bar at the top of the screen which shows a magnified view of an area 

near the mouse pointer.  In Windows 7 Magnifier has become a more powerful full-screen 

magnification tool.  

 

Windows XP:  

1) Hold down the ‘Windows’ key and press the letter ‘R’.  This will display the 

‘Run’ command line.  

2) Type in the word ‘magnify’ and press the ‘Enter’ key.   Alternatively Magnifier 

can also be opened by selecting the ‘All Programs’ section, followed by the 

‘Accessories’ section, followed by the ‘Accessibility’ section and selecting 

‘Magnifier’.  
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3) A message will appear on its first use.  Select the ‘OK’ button.  

4) A magnified bar should now appear at the top of the screen along with a settings 

panel.  The magnified area will follow the mouse when you move it or jump to an 

area where something important is happening on the screen.  To move the focus of 

the window move the mouse arrow.  

5) The magnification level can be adjusted in the ‘Magnifier Settings’ window.  At 

the top of the window is a ‘Magnification level’ option.  Select the pull-down bar  

to increase or decrease the magnification.  

6) The magnification window itself can also be adjusted and moved around.  If you 

wish to move the window move your mouse arrow into the magnified area, select 

it and drag it to another part of the screen.  The size of the window can also be 

adjusted by moving the mouse arrow to the edge of the magnified window, 

selecting the edge and dragging it to another part of the screen.  

 

Windows Vista:  

1) Hold down the ‘Windows’ key and press the letter ‘U’.  

2) Select the ‘Start Magnifier’ option.  This can be done by either directly selecting 

the words ‘Start Magnifier’ or by using the ‘Tab’ key to have the menu options 

read out and pressing the ‘Enter’ key once the words ‘Start Magnifier’ are heard.  

3) A magnified bar should now appear at the top of the screen along with a settings 

panel.  The magnified area will follow the mouse when you move it or jump to an 

area where something important is happening on the screen.  To move the focus of 

the window move the mouse arrow. 

4) The magnification level can be adjusted in the ‘Magnifier’ window.  About a third 

of the way down the window select the ‘Scale factor’ pull-down bar to increase or 

decrease the magnification.  

5) The magnification window itself can also be adjusted and moved around.  If you 

wish to move the window, move your mouse arrow into the magnified area, select 

it and drag it to another part of the screen.  The size of the window can also be 

adjusted by moving the mouse arrow to the edge of the magnified window, 

selecting the edge and dragging it to another part of the screen. 

 

Windows 7:  

1) Hold down the ‘Windows’ key on the keyboard and press the ‘+’ key.  This will 

zoom in on the Windows desktop.     

2) Repeat the above step until the zoom is large enough for your needs.  

3) To reduce the magnification hold down the ‘Windows’ key on the keyboard and 

press the ‘-‘ key. 

4) To scroll around the magnified desktop move the mouse to the area you wish to 

view.  

 

NOTE: The full-screen magnifier switches back to the traditional Magnifier interface 

when a high contrast colour scheme is used.  To switch back to the full-screen magnifier 

select a default theme or colour scheme.   

 

Links to further information on the features and keyboard shortcuts of Magnifier can be 

found in the Additional Tools and Resources section of this manual.  
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5.2 Sound and speech  

5.2.1 Adjusting the volume  

The volume for Windows can be adjusted in Windows 

 

 
 

Figure 5.9 Sound preferences in Windows XP 

 

 

 

Windows XP:  

1) Select the ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Sounds and Audio Devices’.  If there is no ‘Sounds 

and Audio Devices’ icon you may need to switch Control Panel into Classic View.  

This can be done by selecting the words ‘Switch to Classic View’ located on the 

left-hand side. 

4) The ‘Sounds and Audio Devices Properties’ window should appear.  Towards the 

top of the screen is a section labelled ‘Device volume’ with a slide bar.  Select and 

hold the bar and move it left to decrease the volume and right to increase the 

volume.  

5) You may also wish to have the volume control as an icon on the taskbar.  To do 

this, select the checkbox labelled ‘Place volume icon in the taskbar’ just below the 

‘Device volume’ slide bar.   

6) Select  the ‘OK’ button.  

 

Windows Vista and Windows 7:  

1) Select the volume icon appearing as a little sound speaker located in the bottom-

right of the desktop.  

2) A slide bar should appear.  Select and hold the slider and move it up to make the 

sound louder and down to make it softer.  A sample noise at the desired volume 

should sound when the slider is released.  
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5.2.2 ShowSounds and SoundSentry 

ShowSounds and SoundSentry both provide visual cues for audio sounds in Windows.  

 

 
 

Figure 5.10 ShowSounds and SoundSentry preferences in Windows XP 

 

Windows XP:  

1) Select the ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Accessibility Options’.  If there is no ‘Accessibility 

Options’ icon you may need to switch Control Panel into Classic View.            

This can be done by selecting the words ‘Switch to Classic View’ located on the 

left-hand side. 

4) The ‘Accessibility Options’ window should appear.  Select the ‘Sound’ tab located 

in the top-middle of the window. 

5) To enable SoundSentry select the SoundSentry checkbox located towards the top 

of the window. 

6) To enable ShowSounds select the ShowSounds checkbox located towards the 

bottom of the window. 

7) Select the ‘OK’ button.  
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Figure 5.11 ShowSounds and SoundSentry preferences in Windows Vista 

 

Windows Vista and Windows 7:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Ease of Access’. 

4) Select ‘Ease of Access Center’. 

5) Select ‘Use text or visual alternatives for sounds’.  

6) Select the ‘Turn on visual notifications for sounds’ checkbox.  

7) Select the ‘Save’ button.  

 

5.2.3 Toggle Keys  

Toggle Keys will allow Windows to make audio noises when toggle keys are enabled 

such as CAPS LOCK.  

 

Windows XP:  

1) Hold down the ‘NUM LOCK’ key for five seconds to turn on Toggle Keys. 

2) Repeat the step above if you wish to turn off Toggle Keys.  

 

NOTE: For a screenshot of Toggle Keys please refer to Figure 5.18 for Windows XP and 

Figure 5.19 for Windows Vista below. 

 

Windows Vista and Windows 7:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Ease of Access’. 

4) Select ‘Ease of Access Center’. 

5) Select ‘Make the keyboard easier to use’  

6) Select the ‘Turn on Toggle Keys’ checkbox.  

7) Select the ‘Save’ button.  

 

5.2.4 Narrator 

Narrator is a text-to-speech application that allows certain elements in Windows to be 

read out.  

 

Windows XP:  

1) Hold down the ‘Windows’ key and press the letter ‘R’.  This will display the 

‘Run’ command line.  

2) Type in the word ‘narrator’ and press the ‘Enter’ key.   Alternatively Narrator can 

also be opened by selecting the ‘All Programs’ section, followed by the 

‘Accessories’ section, followed by the ‘Accessibility’ section and selecting 

‘Narrator’.  

3) A message will appear the first time Narrator is used.  Select the ‘OK’ button.  

4) Narrator will start reading information to you about the Windows environment.  

To have Narrator read out any window again hold down the ‘CTRL’ key and the 

‘SHIFT’ key followed by pressing the space bar.  
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Windows Vista and Windows 7:  

1) Hold down the ‘Windows’ key and press the letter ‘U’.  

2) Select the ‘Start Narrator’ option.  This can be done by either directly selecting the 

words ‘Start Narrator’ or by using the ‘Tab’ key to have the menu options read out 

and pressing the ‘Enter’ key once the words ‘Start Narrator’ are heard.  

3) Narrator will start reading information to you about the Windows environment.   

To have Narrator read out any window again hold down the ‘CTRL’ key and the 

‘SHIFT’ key, then press the space bar.  

 

Links to further information on the features and keyboard shortcuts of Narrator can be 

found in the Additional Tools and Resources section of this manual.  

 

5.3 Keyboard and mouse  

5.3.1 Adjusting the mouse properties  

The mouse properties allow for the adjustment of the mouse double-click speed, the 

pointer movement speed, the pointer size, the use of mouse pointer trails and the 

ClickLock function.  

 
 

Figure 5.12 Mouse settings in Windows XP (i) 
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Figure 5.13 Mouse settings in Windows XP (ii) 

 
 

Figure 5.14 Mouse settings in Windows XP (iii) 

 

Windows XP:  

1) Select the ‘Start’ button. 

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Mouse’.  If there is no ‘Mouse’ icon, you may need to 

switch Control Panel into Classic View.  This can be done by selecting the words 

‘Switch to Classic View’ located on the left-hand side. 

4) To adjust the double-click speed select and hold the slide bar located in the 

‘Double-lick speed’ section, located about half way down the screen.  Move the 

slide bar left to slow down the speed or right to speed it up. 
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5) To enable the ClickLock function select the checkbox labelled ‘Turn on 

ClickLock’, located towards the bottom of the window.  

6) To adjust the pointer size select the ‘Pointers’ tab at the top of the window, then 

select the ‘Scheme’ pull-down bar located at the top of the window.   Select an 

appropriately large pointer. 

7) To adjust the pointer speed and trails options select the ‘Pointer Options’ tab at the 

top-middle of the window.  To adjust the pointer speed select and hold the first 

slide bar.  Moving the bar left will slow down the speed moving the bar right will 

speed it up.  To add mouse trails select the checkbox labelled ‘Display pointer 

trails’ located towards the bottom of the window under the ‘Visibility’ section. 

8) Select the ‘OK’ button.  

 

 
Figure 5.15 Mouse settings in Windows Vista and Windows 7 (i) 

 

 
Figure 5.16 Mouse settings in Windows Vista and Windows 7 (ii) 
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Figure 5.17 Mouse settings in Windows Vista and Windows 7 (iii) 

 

Windows Vista:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Hardware and sound’. 

4) Select ‘Mouse’. 

5) To adjust the double-click speed select and hold the slide bar located in the 

‘Double-click speed’ section, located about half way down the screen.  Move the 

slide bar left to slow down the speed or right to speed it up. 

6) To enable the ClickLock function select the checkbox labelled ‘Turn on 

ClickLock’, located towards the bottom of the window.  

7) To adjust the pointer size select the ‘Pointers’ tab at the top of the window, then 

select the ‘Scheme’ pull-down bar located at the top of the window.   Select an 

appropriately large pointer. 

8) To adjust the pointer speed and trails options select the ‘Pointer Options’ tab at the 

top-middle of the window.  To adjust the pointer speed select and hold the first 

slide bar.  Moving the bar left will slow down the speed, moving the bar right will 

speed it up.  To add mouse trails select the checkbox labelled ‘Display pointer 

trails’ located towards the bottom of the window under the ‘Visibility’ section. 

9) Select the ‘OK’ button.  

 

Windows 7:  

1) Select the Windows logo ‘Start’ button.  

2) Type the word ‘mouse’ and press the ‘Enter’ key. 

3) The mouse window should appear.  To adjust the double-click speed, select and 

hold the slide bar located in the ‘Double-click speed’ section, located about half 

way down the screen.  Move the slide bar left to slow down the speed or right to 

speed it up. 

4) To enable the ClickLock function select the checkbox labelled ‘Turn on 

ClickLock’, located towards the bottom of the window.  
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5) To adjust the pointer size select the ‘Pointers’ tab at the top of the window, then 

select the ‘Scheme’ pull-down bar located at the top of the window.  Select an 

appropriately large pointer. 

6) To adjust the pointer speed and trails options select the ‘Pointer Options’ tab at the 

top-middle of the window.  To adjust the pointer speed select and hold the first 

slide bar.  Moving the bar left will slow down the speed, moving the bar right will 

speed it up.  To add mouse trails select the checkbox labelled ‘Display pointer 

trails’ located towards the bottom of the window under the ‘Visibility’ section. 

7) Select the ‘OK’ button.  

 

5.3.2 Mouse Keys 

The Mouse Keys function enables the keyboard to be used to move the mouse pointer 

around instead of a mouse.  

 

 
 

Figure 5.18 Mouse accessibility settings in Windows XP 

 

Windows XP:  

1) Select the ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Accessibility Options’.  If there is no ‘Accessibility 

Options’ icon you may need to switch Control Panel into Classic View.  This can 

be done by selecting the words ‘Switch to Classic View’ located on the left-hand 

side. 

4) The ‘Accessibility Options’ window should appear.  Select the ‘Mouse’ tab, 

located in the top-middle of the window. 

5) Select the ‘Use MouseKeys’ checkbox. 

6) Select the ‘OK’ button.  The keys on the numeric keypad can now be used to 

move the mouse pointer.  
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Figure 5.19 Mouse accessibility settings in Windows Vista 

 

Windows Vista and Windows 7:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Ease of Access’. 

4) Select ‘Ease of Access Center’. 

5) Select ‘Make the keyboard easier to use’.  

6) Select the ‘Turn on Mouse Keys’ checkbox.  

7) Select the ‘Save’ button.  

 

5.3.3 Sticky Keys  

 

The Sticky Keys function allows the command keys such as the SHIFT and ALT keys to 

be used without having to keep the relevant key held down.  

 

Windows XP, Windows Vista and Windows 7:  

1) Press the ‘SHIFT’ key five times.  

2) Select the ‘Yes’ button.  

3) To turn off Sticky Keys repeat the first step, then select the ‘No’ button.  

 

5.3.4 Filter Keys  

Filter keys can help prevent mistyping through a tremor or sudden movement on the 

keyboard.  

 

NOTE: For a screenshot of Filter Keys, please refer to Figure 5.18 above. 

 

 

Windows XP:  

1) Select the ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Accessibility Options’.  If there is no ‘Accessibility 

Options’ icon you may need to switch Control Panel into Classic View.  This can 

be done by selecting the words ‘Switch to Classic View’ located on the left-hand 

side. 



 23 

4) The ‘Accessibility Options’ window should appear.  Select the ‘Keyboard’ tab, 

located in the top-left of the window. 

5) Select the ‘Use FilterKeys’ checkbox. 

6) Select the ‘OK’ button. 

 

NOTE: For a screenshot of Filter Keys, please refer to Figure 5.19 above. 

 

Windows Vista and Windows 7:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Ease of Access’. 

4) Select ‘Ease of Access Center’. 

5) Select ‘Make the keyboard easier to use’.  

6) Select the ‘Turn on Filter Keys’ checkbox.  

7) Select the ‘Save’ button.  

 

5.3.5 On-Screen Keyboard  

The On-Screen Keyboard is designed to assist people who use a pointing device such as a 

mouse, joystick or head-mounted device to type. 

 

Windows XP: 

1) Select the ‘Start’ button. 

2) Select ‘All Programs’.  

3) Select ‘Accessories’.  

4) Select ‘Accessibility’. 

5) Select ‘On-Screen Keyboard’.  

6) Load the application in which you wish to type. 

7) Select letters on the On-Screen Keyboard.  The text should appear in your chosen 

application.  

 

Windows Vista:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Ease of Access’. 

4) Select ‘Ease of Access Center’. 

5) Select ‘Start On-Screen Keyboard’.  

6) Load the application in which you wish to type. 

7) Select letters on the On-Screen Keyboard.  The text should appear in your 

application.  

 

Windows 7:  

1) Select the Windows logo ‘Start’ button.  

2) Select ‘Control Panel’.  

3) In the Control Panel select ‘Ease of Access’. 

4) Select ‘Ease of Access Center’. 

5) Select ‘On-Screen Keyboard’.  

6) Load the application in which you wish to type. 

7) Select letters on the On-Screen Keyboard.  The text should appear in your 

application.   
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Links to further information on the features of the On-Screen Keyboard, including the 

new predictive text feature in Windows 7, can be found in the Additional Tools and 

Resources section of this manual.  

6.0 USING WEB BROWSER ACCESSIBILITY FEATURES 

6.1 Web page magnifier  

This feature will zoom into a webpage making the content larger.  

 

Internet Explorer and Firefox:  

1) Hold down the CTRL key on your keyboard. 

2) Press the ‘+’ key to make the text bigger or the ‘-’ key to make the text smaller. 

3) Keep repeating step 2 until the text is at a suitable size. 

 

6.2 Adjusting the text and background colours  

This feature will change the background and text colours of webpages to make them 

easier to see.  

 
Figure 6.1 Changing the colours in Internet Explorer 

 

Internet Explorer:  

1) Go to the ‘Tools’ pull-down menu. 

2) Select ‘Internet Options’. 

3) In the bottom-left hand corner you will see a ‘Colors’ button.  Select this button. 

4) Make sure the ‘Use Windows Colors’ checkbox is not selected. 

5) Select the colours that you want by selecting the current colour and then select a 

new colour. 

6) Select OK on the ‘Colors’ screen. 

7) Select OK on the ‘Internet Options’ screen. 

 

 
Figure 6.2 Changing the colours in Firefox 
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Firefox:  

1) Go to the ‘Tools’ pull-down menu. 

2) Select ‘Options’. 

3) In the top-middle of the box you will see a ‘Content’ box.  Select this box. 

4) In the middle right-hand side of the box you will see a ‘Colours’ button.  Select 

this button. 

5) Select the colours that you want by selecting the current colour and then select a 

new colour. 

6) Select OK on the ‘Colours’ screen. 

7) Select OK on the ‘Options’ screen. 

 

6.3 Additional accessibility features:  

Additional accessibility features are available in this area of the browser settings.  

 

 
Figure 6.3 Accessibility features in Internet Explorer 

Internet Explorer:  

1) Go to the ‘Tools’ pull-down menu. 

2) Select ‘Internet Options’. 

3) Select the ‘Accessibility’ button.  

 

 
Figure 6.4 Accessibility features in Firefox 



 26 

Firefox:  

1) Go to the ‘Tools’ pull-down menu. 

2) Select ‘Options’. 

3) In the top-right of the box you will see an ‘Advanced’ box.  Select this box. Make 

sure the ‘General’ tab is selected. 

 

7.0 ADDITIONAL TOOLS AND RESOURCES  

7.1 Additional tools for people who are blind or vision impaired  

Some people with disabilities need additional tools to help make a computer easier to use.  

For people who are blind or vision impaired a more advanced text-to-speech program is 

available called NVDA.  This program operates a little bit like the built-in tool Narrator, 

but is able to read information from web pages more effectively in Firefox.   NVDA is 

free and can be downloaded from:  

 

http://www.nvda-project.org/ 

 

The Firefox web browser will also need to be downloaded and is available from:  

 

http://www.mozilla.com/en-US/firefox/ 

 

For people that need to use a computer in a public place or in areas where software cannot 

be installed an application called WebAnywhere can help.   WebAnywhere operates as a 

text-to-speech tool that integrates into the web browser, providing basic voice access to 

the Internet.   The voice software can work on almost any computer with sound and will 

start almost immediately by going to the website  

 

http://wa.cs.washington.edu. 

 

The current version of Adobe Acrobat Reader has a feature which lets most documents be 

read out loud. The feature can be used as follows: 

1) Open the document you wish to have read out. 

2) Go to the ‘View’ pull-down menu. 

3) Go to the ‘Read Out Loud’ menu option. 

4) Another menu will appear. Select the reading option that you wish to use. 

NOTE: This feature will only work if the original PDF file is created in an accessible 

manner. 

 

Further information on downloading Adobe Acrobat Reader can be found at  

 

http://get.adobe.com/reader/ . 

 

Information on PDF accessibility can be found on the Adobe Accessibility Resource 

Center at 

 

http://www.adobe.com/accessibility/ . 

 

Additional products are also commercially available.  Contact your local disability 

organisation or Media Access Australia for more information.  

 

http://www.nvda-project.org/
http://www.mozilla.com/en-US/firefox/
http://wa.cs.washington.edu/
http://get.adobe.com/reader/
http://www.adobe.com/accessibility/
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7.2 Online resources  

For further information on the features discussed in this manual, including Narrator 

keyboard shortcuts and the predictive text features of the Windows 7 On-Screen 

Keyboard, please visit the following official websites:  

 

Windows XP accessibility resources:  

http://www.microsoft.com/enable/products/windowsxp/default.aspx 

 

Windows Vista accessibility resources:  

http://www.microsoft.com/enable/products/windowsvista/ 

 

Engineering Windows 7: Microsoft Development blog  

http://blogs.msdn.com/e7/archive/2008/11/30/accessibility-in-windows-7.aspx 

 

Internet Explorer 7 accessibility:  

http://www.microsoft.com/enable/products/ie7/ 

 

 

Firefox accessibility:  

http://kb.mozillazine.org/Accessibility_features_of_Firefox 

 

7.3 Further information  

If you require any further information please contact Media Access Australia 

 

Suite 4.08 

22-36 Mountain Street 

ULTIMO NSW 2007 

Phone: (02) 9212 6242  

T TY: (02) 9212 6242 

Fax: (02) 9212 6289  

Email: info@mediaaccess.org.au 

Website: http://www.mediaaccess.org.au/  

 

Or 

 

Australian Seniors Computer Clubs Association 

Level 4, 280 Pitt Street 

SYDNEY NSW 2000 

Phone: (02) 9286 3871 

Fax: (02) 9286 3876 

Email: office@ascca.org.au 

Website: http://ascca.org.au/barrierfreeaccess/access.htm  

 

 

 

 

http://www.microsoft.com/enable/products/windowsxp/default.aspx
http://www.microsoft.com/enable/products/windowsvista/
http://blogs.msdn.com/e7/archive/2008/11/30/accessibility-in-windows-7.aspx
http://www.microsoft.com/enable/products/ie7/
http://kb.mozillazine.org/Accessibility_features_of_Firefox
mailto:info@mediaaccess.org.au
http://www.mediaaccess.org.au/
mailto:office@ascca.org.au
http://ascca.org.au/barrierfreeaccess/access.htm

